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マイ クロチップ デバイスのコード保護についての詳細

• マイ クロチップ製品は、 マイ ク ロチップが発行するデータ  シートに記載された仕様を満たしています。

• マイ クロチップの製品ファ ミ リは、 正常かつ通常条件下で使用される限り、 現在の半導体市場で最も確実で安全な製品です。

• コード保護を侵害する不正または不法な行為、 または、 マイ ク ロチップが発効するデータ  シートに記載されている仕様範囲外でマイク ロチップ

製品を使用し不正または不法な行為を行った場合は、 知的財産の侵害とな り ます。

• マイ クロチップは、 コードの完全性について懸念されるカスタマをサポート します。

• マイ クロチップおよびその他の半導体メーカは、 コードのセキュ リ ティ を保証しており ません。 コード保護機能は、 製品が破損しないこ とを保
証するものではあ り ません。

コード保護機能は常に改善されています。 マイ ク ロチップでは、 弊社の製品のコード保護機能に対して不断な努力を重ねており ます。 弊社の
コード保護機能を侵害する行為は、 デジタル ミ レニアム著作権法 (DMCA) に違反します。 カスタマのソフ ト ウェアまたはその他の著作物への

不正アクセスが生じた場合は、 この著作権法に則り訴訟を起こす場合があ り ます。
この文書に含まれるデバイス  アプ リ ケーシ ョ ンに関する情

報は、 ユーザーが任意で入手可能できるため、 入手した文書

が常に最新版である とは限り ません。 したがって、 ユーザー

アプリ ケーシ ョ ンが製品仕様を満たしているかの判断はユー

ザー側の責任と します。

マイ ク ロチップは、 条件、 品質、 パフォーマンス、 市場性ま

たは適合性を含む関連情報 ( この限りではない ) が、 明示また

は暗示、 書面または口頭、 制定内またはそ うでない場合でも

いかなる種類の保証を致しかねます。

マイク ロチッ プは、 こ の情報と その使用に起因する全ての責

任を負いかねます。 生命維持装置の重要な構成要素と してマ

イク ロチッ プ製品を使用する場合は、 マイク ロチッ プによる

正式な書面での承認以外は認可されません。 いかなる知的所

有権の下でも 、 明示的またはその他のライセンスの譲渡は認

められません。
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テンビュー ) 品質システムが、 ISO/TS-16949:2002 の認証を取得しま
した。 マイ クロチップの品質システムプロセスおよび手順は、
PICmicro® 8 ビッ ト  MCU、 KEELOQ® コード  ホッピング デバイス、 シ
リ アル EEPROM、 マイ ク ロペリ フェラル、 不揮発性メモ リ、 および
アナログ製品を使用しています。 また、 マイ ク ロチップの開発シス
テムの設計および製造は、 ISO 9001:2000 の認定を取得しています。
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EXPLORER 16 開発ボー ド

ユーザーズ ガイ ド
序章
はじめに

本章では、 Explorer 16 開発ボードを使用するにあたって、 必要な基本情報を提供し
ます。 次の ト ピッ クが含まれます。

• 本資料の概要

• 表記規則

• 保証登録

• 参考資料

• マイクロチップのウェブ サイ ト

• 開発システム カスタマ変更通知サービス

• カスタマ サポート

• 改訂履歴

本資料の概要

このユーザーズ ガイドでは、 Explorer 16 開発ボードを開発ツールとして使用し、 ター
ゲッ ト  ボード上のファームウェアを実行 / デバッグする方法を説明します。

• 第 1 章 : 「Explorer 16 開発ボード」 では、 Explorer 16 開発ボードの概要、 機能、 使用
法を簡単に説明します。

• 第 2 章 : 「Explorer 16 プログラ ミ ング チュート リアル」 では、 MBLAB® IDE を使用
して、 プロジェク ト作成および Explorer 16 開発ボードをプログラムする方法を手順
に従って説明します。

• 第 3 章 : 「Explorer 16 チュート リアル プログラム」 では、 第 2 章 : 「Explorer 16 プ
ログラ ミング チュート リアル」 で作成したプログラムについて説明します。

• 第 4 章 : 「Explorer 16 開発ハードウェア」 では、 Explorer 16 開発ボードのハードウェ
ア機能について詳し く説明します。

• 付録 A. 「Explorer 16 開発ボード  の回路図」 では、 Explorer 16 開発ボードのブロッ ク
図および詳細回路を示します。  

• 付録 B. 「USB 接続のアップデート 」 では、 Explorer 16 開発ボードの USB コネク
ティビティ  システムをアップグレードする方法を示します。

お客様へ

このユーザー ガイ ド を含むすべての文書は予告される こ と な く 更新されます。 マイ ク ロチ ッ プ 
ツールおよび関連資料は、 常にカス タ マのニーズに対応し ているため、 書面文書の内容は、 実際の
ダイアログや説明とは異なる場合があ り ます。 最新の資料は、 弊社のウ ェ ブ サイ ト  
(www.microchip.com) から入手し て く だ さい。

この資料は、 「DS」 と し て分類されます。 資料番号は、 各ページのフ ッ タ部分のページ番号の前に
記載されています。 DS 資料の場合は、 「DSXXXXXA」 とい う番号が付けられています。 XXXXX は
資料番号を表し、 A はリ ビジ ョ ン レベルを表し ます。

開発ツールの最新情報は、 MPLAB® IDE オン ラ イ ン ヘルプを参照し て く だ さい ([Help] メ ニューを
ク リ ッ ク し て、 リ ス ト されているオン ラ イ ン ヘルプ フ ァ イルの ト ピ ッ ク を選択し ます )。
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Explorer 16 開発ボー ド  ユーザーズ ガイ ド
表記規則

このユーザーズ ガイ ドは、 次の表記規則に従います。

保証登録

同封の保証登録カード  (Warranty Registration Card) にご記入いただき、 弊社宛に郵送
してください。 この登録カードを提出されたお客様は、 製品のアップデート版を入
手できます。 暫定ソフ ト ウェア リ リースは、 マイ ク ロチップ ウェブ サイ トからご利
用いただけます。

表記規則

記号 説明 例

Arial または MS P ゴシック フォントの場合

『』 参考資料 『MPLAB® IDE ユーザーズ ガ
イド』

太字 [ ] ウインドウ [Output] ウインドウ

ダイアログ ボックス [Settings] ダイアログ ボック
ス

メニュー セレクション [Enable Programmer] を選
択

ウインドウまたはダイアログ
のフィールド名

[Save project before build]

ダイアログ ボタン [OK] をクリック

タブ [Power] タブ

 < > キーボード キー  <Enter>、<F1>　を押す

[ ] オプションの引数 mcc18 [options] file 
[options]

{ | } いずれかの値を選択する場合 errorlevel {0|1}

･･･ テキストのリピート var_name [, 
var_name...]

ユーザーが定義するコード void main (void)
{...}

Courier New フォントの場合

Courier New サンプル ソース コード #define START

ファイル名 autoexec.bat

ファイル パス c:\mcc18\h

キーワード _asm, _endasm, static

コマンド ライン オプション -Opa+, -Opa-

ビット値 0, 1

定数 ( ソース コード ) 0xFF, ‘A’

変数引数 file.o 
(file= 有効なファイル名 )
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序章
参考資料

このユーザーズ ガイ ドでは、 Explore 16 開発ボードの使用方法について説明します。
次にマイ クロチップのその他の参考資料を紹介します。

Explorer 16 開発ボードの Readme ファ イル

Explore 16 開発ボードを使用する際の最新情報は、Explorer 16 開発ボード  CD-ROM の
ルート  レベルに保存されている  Readme for Explorer 16 Development 
Board.txt ファ イル (ASCII テキス ト  ファ イル ) を参照して ください。このファ イル
には、 本資料に記載されていない最新情報および既知の問題などが含まれる場合が
あ り ます。

Readme ファ イル

その他のツールを使用する際の最新情報は、 MPLAB IDE インス トール ディ レク ト リ
の Readme サブディ レク ト リの中に保存されている特定ツールの Readme ファ イルを
参照して ください。 このファ イルには、 本資料に記載されていない最新情報および
既知の問題などが含まれる場合があ り ます。

『PIC24FJ128GA010 PS データ  シート 』 (DS39756) および 『PIC24FJ128GA ファ ミ リ  
データ  シート 』 (DS39747) 
PIC24F および 16 ビッ ト  デバイス  の詳細情報は、 これらの資料を参照して ください。
これらのデータ  シートには、 次のよ うな情報が記載されています。

• デバイスのメモリ  マップ

• デバイスのピン配置およびパッケージの詳細

• デバイスの電気特性

• デバイスに含まれるペリ フェラルのリ ス ト

DS39756 は、 PIC24F ファ ミ リの初期プロ ト タイプ サンプル専用の資料です。 これら
のデバイスは、 型番の末尾に 「PS」 の文字がマーキングされています。 その他の 
PIC24FJ128GA ファ ミ リ  デバイス  (ES デバイスを含む ) を使用する場合は、 DS39747 
を参照して ください。

『dsPIC33F ファ ミ リ  データ  シート 』 (DS70165)
dsPIC33F デジタル シグナル コン ト ローラの詳細情報は、 この資料を参照して くださ
い。 このデータ  シートには、 次のよ うな情報が記載されています。

• デバイスのメモリ  マップ

• デバイスのピン配置およびパッケージの詳細

• デバイスの電気特性

• デバイスに含まれるペリ フェラルのリ ス ト

『dsPIC30F プログラマ リ ファレンス  マニュアル』 (DS70030)
この資料は、 マイ ク ロチップのすべての 16 ビッ ト  デジタル シグナル コン ト ローラ
に関するソフ ト ウェア開発者用のリ ファレンス  マニュアルです。 命令セッ トの詳細
や PIC24 MCU、 dsPIC30F、 および dsPIC33F DSC のソフ ト ウェア開発で必要な情報も
提供します。

『PIC24H ファ ミ リの概要』 (DS70166)
この資料では、 最新の PIC24H ファ ミ リ機能について説明しています。 PIC24H の高
性能 16 ビッ ト  マイ ク ロコン ト ローラが特定製品アプリ ケーシ ョ ンに最適な理由など
を説明しています。 
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Explorer 16 開発ボー ド  ユーザーズ ガイ ド
『MPLAB® C30 C Compiler ユーザーズ ガイ ド』 (DS51284)
この資料では、dsPIC® デバイスにマイ ク ロチップ MPLAB C30 C Compiler を使用して
アプ リ ケーシ ョ ンを開発する方法を説明しています。 MPLAB C30 は、 GNU ベース
の言語ツールであ り、FSF (Free Software Foundation) のソースに基づいています。FSF 
の詳細は、 www.fsf.org を参照して ください。

その他のマイ クロチップ GNU 言語ツールを次に示します。

• MPLAB ASM30 アセンブラ

• MPLAB LINK30 リ ンカ

• MPLAB LIB30 ライブラ リアン / アーカイバ

『MPLAB® IDE シ ミ ュレータおよび エディ タ  ユーザーズ ガイ ド』 (DS51025)
MPLAB IDE ( 統合開発環境 ) ソフ ト ウェアのインス トールおよびインプ リ メンテー
シ ョ ンに関する情報が記載されています。 

マイ ク ロチ ッ プのウ ェ ブ サイ ト

マイ ク ロチップは、ウェブ サイ ト  (www.microchip.com) ではオンライン  サポート を提
供しています。 このウェブ サイ トからいつでも容易に情報を入手できます。 ご使用
のインターネッ ト  ブラウザからアクセス可能であ り、 主な内容は次のとおりです。

• 製品サポート  – データ  シート、 エラ ッタ、 アプリケーシ ョ ン ノート、 サンプル プ
ログラム、 デザイン リ ソース、 ユーザーズ ガイ ド、 ハードウェア サポート  ド
キュ メン ト、 最新ソフ ト ウェア リ リース、 アーカイブ ソフ ト ウェア。

• テクニカル サポート  – FAQ、 テクニカル サポートのリ クエス ト、 オンライン ディ
スカッシ ョ ン グループ、 マイクロチップ顧問プログラム  メンバー

• 一般情報 – 製品紹介および製品注文ガイ ド、 最新のマイクロチップ プレス  リ リー
ス、 セミナーおよびイベン ト情報リ ス ト、 マイクロチップ営業所リ ス ト、 販売代
理店およびファ ク ト リ情報
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序章
開発システム カス タ マ変更通知サービス

マイ ク ロチップのカスタマ通知サービスでは、 マイ ク ロチップ製品の最新情報を提
供いたします。 このサービスにご登録される と、 特定製品ファ ミ リ または開発ツー
ルに関連する変更、 アップデート、 改訂、 またはエラ ッ タが発効された場合に、 電
子メールで通知を受け取るこ とができます。

登録方法は、 マイ ク ロチップのウェブ サイ ト  (www.microchip.com) から、 [Change 
Notification] をク リ ッ ク して、 インス ト ラ クシ ョ ンに従ってください。

開発システムの製品は次のよ うに分類されます。

• コンパイラ  – Microchip C コンパイラおよびその他の言語ツールに関する最新情報
を提供します。 MPLAB C18 および MPLAB C30 C コンパイラ、 MPASM™ および 
MPLAB ASM30 アセンブラ、 MPLINK™ および MPLAB LINK30 オブジェク ト  リ ン
カ、 MPLIB™ および MPLAB LIB30 オブジェク ト  ライブラ リアンを含みます。

• エミ ュレータ  – マイクロチップのインサーキッ ト  エミ ュレータに関する最新情報
を提供します。 MPLAB ICE 2000 および MPLAB ICE 4000 を含みます。

• インサーキッ ト  デバッガ –  マイクロチップのインサーキッ ト  デバッガ (MPLAB 
ICD 2) に関する最新情報を提供します。

• MPLAB® IDE – マイクロチップ MPLAB IDE  ( 開発システム ツール用 Windows® 統
合開発環境 ) に関する最新情報を提供します。 MPLAB IDE、 MPLAB SIM シ ミ ュ
レータ、 MPLAB IDE Project Manager、 および一般的な編集およびデバッグ機能を
含みます。

• プログラマ – マイクロチップ プログラマに関する最新情報を提供します。MPLAB 
PM3 と  PRO MATE® II デバイス  プログラマおよび  PICSTART® Plus   と  PICkit™ 1  
開発プログラマを含みます。

カス タ マ サポー ト

マイ ク ロチップ製品のサポートは、 次のとおりです。

• 販売代理店またはセールスレップ

• 営業所

• フ ィールド  アプリケーシ ョ ン エンジニア (FAE)
• テクニカル サポート

• 開発システム情報ライン

サポートが必要な場合は、 販売代理店、 セールスレップ、 または FAE までご連絡く
ださい。 お近くの営業所でもサポート を受けられます。 営業所および連絡先の詳細
は、 本資料の最終ページに記載しています。

テクニカル サポートは、 ウェブ サイ ト  (http://support.microchip.com) からご依頼くだ
さい。

改訂履歴 
リビジョン A (2005 年 9 月 )

本文書は、 初版リ リースです。
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EXPLORER 16 開発ボー ド

ユーザーズ ガイ ド
第 1 章 :   Explorer 16 開発ボー ド
1.1 はじめに

マイ ク ロチップ テク ノ ロジーの Explorer 16Explorer 16 開発ボードをご購入いただき
まして、 あ りがと う ございました。 この開発ボードは、 マイ ク ロチップの最新 16 
ビッ ト  マイ クロコン ト ローラ  ファ ミ リ  (PIC24F、PIC24H) および 16 ビッ ト  デジタル 
シグナル コン ト ローラ  ファ ミ リ  (dsPIC33F) に対応する、 低コス ト なモジュール開発
システムを提供します。

この開発ボードは、 開封後すぐにデモ ボード と して使用できます。 また、 モジュー
ル拡張インターフェイスを使用する とファンクシ ョ ンの拡張も可能です。Explorer 16 
開発ボードは、 MPLAB ICD2 のエ ミ ュレーシ ョ ン機能およびデバッグ機能を完全に
サポート しており、 3V コン ト ローラが 5V ペリ フェラル デバイスへ接続できるよ う
にな り ます。

1.2 ハイ ラ イ ト

本章では、 次の ト ピッ クについて説明します。

• キッ トに含まれるもの

• Explorer 16 開発ボードの機能および特長

• Explorer 16 開発ボードの使用について

• Explorer 16 開発ボードのデモンス ト レーシ ョ ン  プログラム

• 参考資料

1.3 キッ ト に含まれる もの

Explorer 16 開発ボード  キッ トには次のものが含まれています。

• Explorer 16 開発ボード  
• あらかじめプログラムされた PIC24FJ128GA010 PIM ( プロセッサ インス トール 
モジュール ) - すでにインス トール済み 

• あらかじめプログラムされた dsPIC33FJ256GP710 PIM
• RS-232 ケーブル 1 本
• Explorer 16 開発 CD ROM 

- 本ユーザーズ ガイ ド

- PIC24FJ128GA ファ ミ リおよび dsPIC33FJ256GP ファ ミ リのデータシート

- PIM モジュールの回路図および PCB 図
- PIC24 および dsPIC33F デバイスで使用するプログラム例 
- Explorer 16 開発ボード と併用可能な汎用拡張ボードの詳細を含むファ イル (
ガーバー形式 )

上記の内容が含まれていない場合は、 お近くのマイ ク ロチップ営業所 ( 本書の最終
ページに記載 ) までご連絡くださ  い。   
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1.4 Explorer 16 開発ボー ドの機能および特長

図 1-1 に、 エクスプローラ開発ボードのレイアウ ト を示します。 このボードには、 次
の機能が含まれています。

1. 100 ピン  PIM ライザー ソケッ ト  ( すべてのマイク ロチッ プ PIC24F/24H/dsPIC33F 
デバイスの PIM バージョ ンに準拠 ) 

2. ボードに 9V の DC 電源を投入する と、 ボード上で 3.3V と 5V ( 規制有り ) の電
源が作られる

3. 電源インジケータ  LED
4. RS-232 シ リ アル ポートおよび関連ハード ウェア

5. オンボード  アナログ温度センサー

6. 通信およびデバイス  プログラ ミ ング / デバッグ用 USB コネクティ ビティ

7. MPLAB ICD 2 プログラマ / デバッガ モジュールへ接続するための、標準 6 ワイ
ヤのインサーキッ ト  デバッガ (ICD) コネクタ

8. PIM または、 ボード上実装済みマイク ロコン ト ローラのハード ウェア選択ス
イ ッチ ( 今後のバージ ョ ン対象 )

9. 16 文字 x 2 行 LCD モニタ

10. アドオン  グラフ ィ ッ ク  LCD 用の PCB 上プロビジ ョ ニング機能

11. デバイスのリセッ トおよびユーザー指定の入力用プッシュ  ボタン式スイ ッチ

12. アナログ入力用ポテンシ ョ メーター

13. 8 個のインジケータ  LED
14. シ リ アル通信ラインを選択 / 切り替え可能なコンフ ィギュレーシ ョ ン用 

74 HCT 4053 マルチプレクサ

15. シ リ アル EEPROM
16. 正確なマイ ク ロコン ト ローラ  ク ロ ッキング動作用 (8MHz) および RTCC 動作用  

(32.768kHz) の独立ク リ スタル

17. カスタム  アプ リ ケーシ ョ ンの開発用プロ ト タイプ エリ ア

18. PICtail Plus カードを使用できるソケッ トおよびエッジ コネク タ

19. PICkit 2 プログラマ用の 6 ピン  インターフェイス

20. オプシ ョ ンのバウンダ リ  スキャン用の JTAG コネクタ  パッ ド

これらの機能の詳細は、 第 4 章 :「 Explorer 16 開発ハード ウェア」 を参照して くださ
い。

1.4.1 開発キ ッ ト に含まれるサンプル デバイス

各 Explorer 16 開発ボー ド キッ ト には、 2 つのプログラム済み 16 ビ ッ ト  デバイス 

(PIC24FJ128GA010 および dsPIC33FJ256GP710) が含まれています。 これらのデバイス
は、 ラ イザー ソケ ッ ト を使用した 100 ピン PIM と し て提供されているため、 ピン 
ヘッ ダ U1A にすぐに取り付け可能です。 またこれらは必要に応じ て交換できます。

メ モ : Explorer 16 開発ボー ドは、 U1 に実装される PIC24FJ128GA010 デバイ
スから機能するよ う に設計されています。 出荷時は、 U1 には何も配置さ
れていない状態で出荷され、 代わり に同等のフ ァ ン ク シ ョ ンである  
PIC24FJ PIM が U1A ヘ ッ ダにマウン ト されています。PIC24FJ PIM また
はその他の PIM を使用する場合は、 必ず S2 スイ ッ チを 「PIM」 位置に保
持し て く だ さい。 詳細は、 4.2.1 「プロセ ッサ サポー ト 」 を参照し て く だ
さい。
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図 1-1: Explorer 16 開発ボー ドのレイアウ ト

1.5 Explorer 16 の使用

このボードは、 開発プラ ッ ト フォームと して提供されていますが、 開封後すぐに 
PIC24 および dePIC33F デバイス用のデモンス ト レーシ ョ ン  ボード と しても使用でき
ます。 第 3 章 : 「Explorer 16 チュート リ アル プログラム」 で説明するプログラムは、
サンプル デバイス  PIM  (PIC24 デバイス  : PIC24ExplDemo.hex、 dsPIC33F デバイス  : 
dsPIC33ExplDemo.hex) にあらかじめプログラムされているため、 開封後すぐに使用
できます。 
ボードの使用手順を次に示します。

1. PIC24FJ デバイスが実装されていない Explorer 16 ボードの場合 : まず、 
PIC24FJ128GA010 PIM がボードに正常にインス トールされているこ とを確認し
ます。 dsPIC デバイスを使用する場合は、 PIM24 PIM を丁寧に取り外し、 その
場所に desPIC33F PIM をインス トールします。 PIM を使用する場合は、 PIM の
角がくぼんだ部分を左上にして配置して ください。

2. PIC24FJ デバイスが実装されていない Explorer 16 ボードの場合 : S2 スイ ッチが 
PIM 位置に設定されているこ とを確認します。
PIC24FJ デバイスが実装されている Explorer 16 ボードの場合 : S2 スイ ッチが 

メ モ : マイ ク ロチ ッ プの 16 ビ ッ ト 製品フ ァ ミ リが進化するにつれ、Explorer 16 
開発ボー ド  キ ッ ト に含まれるデバイスは変更される場合があ り ます。
PIC24 フ ァ ミ リ および dsPIC33F フ ァ ミ リのデバイスは常に 1 つずつ含
まれる予定です。 また今後は、 PIC24 デバイスはボー ド にはんだ付けさ
れ、 dsPIC33F デバイスのみ PIM と し て提供されます。
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PIC 位置に設定されているこ とを確認します。

3. JP2 のジャンパがインスト ールされていること を確認します (LED を有効にする )。
4. 電源入力 J2 に電源 (9 VDC) を投入します。 使用可能な電源ソースの詳細は、

付録 A. 「Explorer 16 開発ボード  の回路図」 を参照して ください。

デモンス ト レーシ ョ ン  コードの動作の詳細は、 第 3 章 : 「Explorer 16 チュート リ アル 
プログラム」 を参照して ください。

図 1-2: Explorer 16 PIM モジュールの角が く ぼんだ部分  
( 左上の角 )

1.6 Explorer 16 開発ボー ドのデモ プログラム

Explorer 16 CD ROM には、 PIM  にあらかじめプログラムされたサンプル コードが参
照用と して含まれています。 すべてのプロジェク ト  ファ イルがあるため、 サンプル 
デバイスが別のプログラムによって再プログラムされた場合などに、 コードを直接
使用して PIM をオ リジナル状態に回復できます。 また、 チュート リ アル コードを今
後の開発用のプラ ッ ト フォームと しても使用できます。

さ らに CD-ROM には、 PIC24 および dsPIC33F 両デバイス用のサンプル デモ プログ
ラムが含まれています。各ファ ミ リ  デバイス用に個別のデモ ソース  コード  (C 言語 ) 
およびコンパイルされたコード  ファ イル (16 進数 ) があ り ます。 これらは、 MPLAB 
ICD 2 を使用して PIC24 および dsPIC33F PIM デバイスを再プログラムできます。

1.7 参考資料

「参考資料」 で紹介する資料のほかに、 Explorer 16 開発 ボードを使用する際に役立
つ、 マイ ク ロチップの資料を次に示します。

• PIC18F2455/2550/4455/4550 データシート  (DS39632)
• TC1047/TC1047A データシート  (DS21498)
• 25AA256/25LC256 データシート  (DS21822)
• PICkit™ 2 マイ ク ロコン ト ローラ  プログラマ ユーザーズ ガイ ド  (DS51553)
• MPLAB® ICD 2 インサーキッ ト  デバッガのク イ ッ ク  スタート  ガイ ド  (DS51268)
• PRO MATE® II ユーザーズ ガイ ド  (DS30082)
これらの資料は、 お近くのマイ ク ロチップ営業所、 またはウェブ サイ ト  
(www.microchip.com) からダウンロード して入手できます。

PIC24FJ128GA010
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ユーザーズ ガイ ド
第 2 章 :   Explorer 16 プログラミ ング チュート リ アル
2.1 はじめに

本章では、 Explorer 16 開発ボードの使用についてチュート リ アル方式で説明します。

2.2 ハイ ラ イ ト

本章の主な内容

• チュート リ アルについて

• プロジェク トの作成

• コードの構築

• デバイスのプログラ ミ ング

2.3 チュー ト リ アルについて

本章のチュート リ アルでは、Explorer 16 開発ボードで使用される  MPLAB IDE および 
MPLAB ICD 2 の主な機能について説明します。 このボードは、 PIC24FJ128GA010 デ
バイス用に設計されていますが、 PIC24H または dsPIC33F に対しても同じ手順およ
び同じツール スイート を使用できます。

本章で実行する  PIC24 チュート リ アルのプロジェク トは、 PIC24ExplDemo.mcp 
(MPLAB C30 用に Ｃ  言語で記述 ) です。 このプログラムは、 英数字の LCD に PIC24 
の内容を表示します。 また、 ボタン操作で、 電圧、 温度、 および日付 / 時間も表示で
きます。 dsPIC チュート リ アルのプロジェク トは、 Example1_RTC_LED_ADC.mcp 
です。 これも、 MPLAB C30 用に C 言語で記述されています。 このプログラムは、 電
圧および現在時間を表示し、 コマンドで表示画面をアップデート します。 この 2 つ
のプログラムの詳細は、 第 3 章 : 「Explorer 16 チュート リ アル プログラム」 を参照し
て ください。

どちらのプロジェク トの場合でも、 ソース  ファ イル (PIC24 の場合は  
PIC24ExplDemo.c、 dsPIC33F の場合は main_rtc.c) と共に、 リ ンカ スク リプ ト  
(p24fj128ga010.gld または p33fj256gp710ps.gld) およびヘッダ ファ イル 
(p24fj128ga010.h または p33fj256gp710ps.h) が使用され、 プロジェク トが
完成します。 このよ う な単純なプロジェク トでは、 1 個のソース  ファ イルを使用し
ますが、 複雑なプロジェク トでは、 複数のアセンブラおよびコンパイラ  ソース  ファ
イルを使用し、 またライブラ リ  ファ イルおよびプリ コンパイル済みのオブジェク ト  
ファ イルも複数使用する場合があ り ます。

このチュート リ アルを始めるにあたって、 次の要件が必要です。

• Project Wizard を使用してプロジェク ト を作成する

• コード をアセンブルおよびリ ンク し 、 コンフィ ギュレーショ ン  ビッ ト を設定する

• MPLAB ICD 2 を使用するために MPLAB IDE をセッ ト アップする

• MPLAB ICD 2 を使用してチップをプログラムする

このチュート リ アルは、 次の 3 つの手順で構成されています。

1. MPLAB IDE でプロジェク ト を作成する

2. コードをアセンブ リおよびリ ンクする

3. MPLAB ICD 2 でチップをプログラムする
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2.4 プロジ ェ ク ト の作成

最初の手順は、 MPLAB IDE でプロジェク ト を作成し、 作業スペースを作成します。
通常、 1 プロジェク トに対して 1 作業スペース使用します。

1 つのプロジェク トには、 アプ リ ケーシ ョ ンを構築する上で必要なファ イル ( ソース  
コード、 リ ンカ スク リプ ト  ファ イルなど ) が含まれ、 構築ツールや構築オプシ ョ ン
との接続が含まれます。

1 つの作業スペースには 1 個または複数のプロジェク トが含まれ、 選択したデバイス
情報、 デバッグ ツール / プログラマ情報、 ウインド ウ表示と ロケーシ ョ ン情報、 お
よびその他の MPLAB　 IDE コンフ ィギュレーシ ョ ン設定情報が含まれます。

MPLAB IDE には、 新規プロジェク ト を作成するための Project Wizard が含まれます。
チュート リ アルを始める前に、 プロジェク ト  ファ イル用に 「Tutorial」 という名前の
フォルダを作成して ください ( 以下のインス ト ラ クシ ョ ンでは、 c:\Tutorial を使
用 )。次に、Explorer 16 開発キッ ト  ソフ ト ウェア CD-ROM のディ レク ト リ Example 
Code\Tutorial Code から、 ソース  ファ イルをコピーして、 このフォルダへ移動
します。

2.4.1 デバイスを選択する

1. MPLAB IDE を起動します。

2. [File] → [Close Workspace] をク リ ッ ク して作業スペースを閉じます。

3. [Project] メニューから  [Project Wizard] を選択します。

4. Welcome 画面で [Next] をク リ ッ クする と、Project Wizard の [Step One] ウインド
ウが表示されます。 

図 2-1: デバイスの選択

5. [Device] のド ロップダウン  リ スト から、 [PIC24FJ128GA010] または 
[dsPIC33FJ256GP710PS] を選択します ( 使用する  PIM によって異なる )。 [Next] をク
リ ッ クすると 、 Project Wizard の [Step Two] ウインド ウが表示されます ( 図 2-2 参照 )。

メ モ : MPLAB IDE 7.22 以降のバージ ョ ンを使用し て作業を行っ て く だ さい。

メ モ : 次のセクシ ョ ンのスク リーン シ ョ ッ ト は、 PIC24 のチュー ト リ アルを示し
ています。 フ ァ イル名以外は、 dsPIC33F のチュー ト リ アルと同一です。
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図 2-2: ツール スイー ト の選択

2.4.2 言語ツール スイー ト を選択する

1. [Active Toolsuite] のド ロ ップダウン リ ス トから、[Microchip C30 Toolsuite] を選
択します。 このツール スイートには、 使用するアセンブラおよびリ ンカが含
まれています 

2. [Toolsuite] ボッ クスで [MPLAB C30 Compiler (pic30-gcc.exe)] を選択します。

3. [Location] ボッ クスで [Browse] をク リ ッ ク し、 次を参照します。 
C:\Program Files\Microchip\MPLAB C30\bin\pic30-as.exe

4. [Toolsuite Contents] で MPLAB LINK 30 Object Linker (pic30-ld.exe) を選択し、
[Location] ボッ クスで次を参照します。
C:\Program Files\Microchip\MPLAB C30\bin\pic30-Id.exe

5. [Next] をク リ ッ クする と、 Project Wizard の [Step Three] ウインド ウが表示され
ます ( 図 2-3)。
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図 2-3: プロジ ェ ク ト 名の入力

2.4.3 プロジ ェ ク ト 名を入力する

1. [Project Name] ボックスに 「MyProject」 と入力します。 
2. [Project Directory] ボックスで [Browse] をクリックして次を参照します。 

C:\Tutorial to place your project in the Tutorial folder
3. [Next] をク リ ッ クする と、 Project Wizard の [Step Three] ウインド ウが表示され

ます  ( 図 2-4 参照 )。

図 2-4: プロジ ェ ク ト にフ ァ イルを追加 
DS51589A_JP-page 14   © 2005 Microchip Technology Inc.



Explorer 16 プログラ ミ ング チュー ト リ アル
2.4.4 プロジ ェ ク ト にフ ァ イルを追加する

1. PC フォルダのリストから、C:\Tutorial フォルダを検索します。

2. ソース ファイル (.c) とヘッダ ファイル (.h) を選択し、[Add] をクリックす
ると、プロジェクトにこれらのファイルが追加されます。

3. C:\Pogram Files\Microchip\MPLAB 30\support\gld folder を展開表
示して、p24fj128ga010.gld または p33fj256gp710ps.gld ファイルを
選択します。

4. [Add] をクリックすると、プロジェクトに選択したファイルが追加されます。
これでプロジェクトには 2 つのファイルがあります。  

5. [Next] をクリックして次の画面を表示します。

6. サマリ画面が表示されると、[Finish] をクリックします。

Project Wizard 終了後、 MPLAB のプロジェク ト  ウインド ウでは、 ソース  ファ イル 
フォルダにソース  ファ イルが表示され、 リ ンカ スク リプ ト  フォルダーに適切な リ ン
カ スク リプ トが表示されます ( 図 2-5)。

図 2-5: プロジ ェ ク ト  ウイ ン ド ウ

MPLAB IDE でプロジェク ト と作業スペースが作成されました。 MyProject.mcw が
作業スペース  ファ イルで、 MyProject.mcp がプロジェク ト  ファ イルです。 プロ
ジェク ト  ウインド ウで、 PIC24ExplDemo.c file (PIC24 の場合 ) または 
main_rtc.c file (dsPIC33F の場合 ) をダブルク リ ッ ク してファ イルを開きます。
図 2-6 に、 MPLAB IDE の画面を示します。
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図 2-6: MPLAB® IDE の作業スペース 

2.5 コー ド構築

このプロジェク トでは、 ソース  ファ イルをコンパイルするためのコードを構築し、
オブジェク ト  ファ イル (MyProject.o) を作成します。 また、 オブジェク ト  ファ イ
ルを リ ンク し、 MyProject.hex と  MyProject.cof 出力ファ イルを作成します。
(dsPIC33F プロジェク トの場合、 このファ イルは、 Example1_RTC_LED_ADC.o、
Example1_RTC_LED_ADC.hex、 および Example1_RTC_LED_ADC.cof と なり ま
す。 ) HEX ファ イルには、 デバイスをプログラムする際に必要なデータが含まれてお
り、 COF ファ イルには、 ソース  コード  レベルでのデバッグのための追加情報が含ま
れています。

コード構築の前に、 インクルード  ファ イルの場所や MPLAB ICD 2 を使用する と きの
追加デバッグ コードを保存する場所などを  MPLAB IDE が認識できるよ うに設定し
ます。 PIC24 プロジェク トの場合、 system.h ファ イルに次の行があ り ます。

#include “p24fj128ga010.h”

dsPIC33 プロジェク トの場合は次の行があ り ます。

#include “p33fj256gp710ps.h”

この行によ り、 標準のインクルード  ファ イルが使用されます。 マイ ク ロチップは、
これらのファ イルに SFR ( 特別機能レジスタ ) を割り当てます。 
コード構築するには、 [Project] メニューから  [Build Options] → [Project] をク リ ッ ク
します。 [Build Options] ウインド ウが表示されます ( 図 2-7)。

出力

ウイ ン ド ウ

ソース

ウイ ン ド ウ
コー ド

プロジ ェ ク ト
ウイ ン ド ウ
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図 2-7: [BUILD OPTIONS] ウイ ン ド ウ 

2.5.1 アセンブ ラ  イ ン クルー ド  フ ァ イルの確認

1. [General] タブを選択します。

2. [Suite Default] をクリックすると、ライブラリ ファイルの場所が表示されます。

3. [MPLAB LINK30] タブを選択すると、リンカ設定が表示されます ( 図 2-8)。
4. [Link for ICD2] を確認します。

5. [OK] をク リ ッ ク します。 テキス ト ボッ クスは終了しますが、 リ ンカは、
MPLAB ICD 2 で使用されるデバッグ コード用のスペースを確保します。

6. 再度 [OK] をク リ ッ ク し、 すべての変更を保存します。 これでプロジェク トの
構築準備が完了しました。
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図 2-8: MPLAB® LINK30 の [BUILD OPTIONS] ウイ ン ド ウ

2.5.2 プロジ ェ ク ト を作成する

MPLAB IDE ウインド ウのメニュー バーから、 [Project] → [Make] を選択し、 [Out-
put] ウインド ウが表示されます ( 図 2-9)。
このウインド ウで構築プロセスをモニタできます。 「BUILD SUCCEEDED」 という
メ ッセージが表示される と、 デバイスをプログラムする準備が整ったこ とを意味し
ます。

図 2-9: [OUTPUT] ウイ ン ド ウ
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2.6 デバイスのプログラム

MPLAB ICD 2 インサーキッ ト  デバッガを使用して、 Explorer 16 開発ボード上でプロ
グラムおよびマイ ク ロコン ト ローラをデバッグします。

2.6.1 デバイス コ ン フ ィ ギュ レーシ ョ ンを設定する

ターゲッ ト  マイ ク ロコン ト ローラのデバイス  コンフ ィギュレーシ ョ ンには 2 つの設
定方法があ り ます。 1 つは、 ソース  コードでコンフ ィギュレーシ ョ ン  マクロを使用
する方法、 も う  1 つは、 MPLAB IDE で コンフ ィギュレーシ ョ ン  ビッ ト を使用する方
法です。

PIC24 Explorer 16 のチュート リ アル コードでは、 すでにソース  コードにコンフ ィ
ギュレーシ ョ ン マクロが含まれているため、 PIC24ExplDemo.c ファ イルの上部付
近に次のマクロがあるこ とを確認します。

_CONFIG1(JTAGEN_OFF & GSS0_OFF & GWRP_OFF & BKBUG_OFF & COE_OFF 
& FWDTEN_OFF & FNOSC_PRI) 
_CONFIG2(FCKSM_CSDCMD & OSCIOFNC_ON & POSCMOD_HS)

dsPIC33F チュート リ アル コードの場合は、 main_rtc.c ファ イルの上部付近に次の
マクロがあるこ とを確認して ください。

_FGS(CODE_WRITE_PROT_OFF);

_FOSCSEL(FRC_PLL);

_FOSC(CSW_FSCM_OFF & OSC2_IO & XT);

_FWDT(WDT_OFF);

ソース  コードでコンフ ィギュレーシ ョ ン  マクロが使用されていない場合は、 コン
フ ィギュレーシ ョ ン ビッ ト  ウインド ウでデバイス  コンフ ィギュレーシ ョ ンを設定す
るこ と も可能です。 PIC24 コードの場合は、 次の手順に従います。

1. メイン ウインドウのメニュー バーから [Configure] → [Configuration Bits] を
選択し、コンフィギュレーション設定ウインドウを表示します ( 図 2-10)。  

2. 指定するラインの項目をクリックし、ドロップダウン メニューからオプショ

ンを選択してコンフィギュレーション ビットを設定します。コンフィギュ
レーション ビットは、図 2-10 で示すとおりに設定してください。 
変更する可能性がある設定を次に示します。

a) [Primary Oscillator Select] : HS Oscillator Enabled
b) [Oscillator Select] : Primary Oscillator (XT, HS, ES)
c) [Clock Switching and Monitor] : SW Disabled, Mon Disabled
d) [Watchdog Timer Enable] : Disable

メモ : まず最初に、 MPLAB ICD 2 用の USB ド ラ イバが PC にインス トールされ
ているこ とを確認して ください。 MPLAB ICD 2 のインス トールについて
は、 『MPLAB® ICD 2 インサーキッ ト  デバッガ ユーザーズ ガイ ド』 
(DS51331) を参照して ください。
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図 2-10: コ ン フ ィ ギュ レーシ ョ ン設定 (PIC24)

2.6.2 MPLAB ICD 2 の接続および使用

1. USB ケーブルを使用して、MPLAB ICD 2 モジュールと PC を接続します。

2. 短い RJ-11 ケーブルを使用して、MPLAB ICD 2 と Explorer 16 開発ボードを
接続します。  

3. Explorer 16 開発ボードに電源を投入します。

4. [Debugger] メニューから、[Select Tool] → [MPLAB ICD 2] を選択し、MPLAB 
IDE で MPLAB ICD 2 をデバッグ ツールとして設定します。

5. [Debugger] メニューから、[Connect] を選択してデバッガ ツールとデバイスを

接続します。MPLAB IDE が、 PIC24FJ128GA010 との接続を認識する と、
図 2-11 のよ うなレポートが表示されます。

図 2-11: MPLAB® ICD 2 のイネーブル設定

メ モ : コ ンフ ィ ギュ レーシ ョ ン マク ロがすでにソース コー ド で使用されている場
合は、 コ ンフ ィ ギュ レーシ ョ ン ビ ッ ト  ウイン ド ウを使用してデバイス コ
ンフ ィ ギュレーシ ョ ンを設定してはいけません。 両方の方法が同時に使用
された場合は、 コ ンフ ィ ギュレーシ ョ ン マク ロがコ ンフ ィ ギュレーシ ョ ン 
ビ ッ ト  ウイン ド ウでの設定を上書き し ます。 詳細は、 『MPLAB IDE 
Simulator, Editor User’s Guide(DS51025)』 を参照して く ださい。 

メ モ : PIC24FJ デバイス と接続する MPLAB ICD 2  を初めて使用する場合、
MPLAB IDE では、 新しいフ ァームウ ェ アのダウンロー ドが必要な場合が
あ り ます。 関連するエラー メ ッ セージが表示された場合は、 メ ッ セージ
をダブルク ロ ッ ク し て詳細情報を入手し て く だ さい。

Status indicates 
device is found
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2.6.3 デバイスをプログラムする

1. [Debugger] メ ニューから、 [Program] を選択してデバイスをプログラムします。
[Output] ウインド ウでは、 実行されるプログラムのシーケンスが表示されます 
( 図 2-12)。 

2. プログラミ ング結果を確認します。 「 MPLAB ICD 2 Ready」 が表示された場合は、
デバイスのプログラミ ングが完了し、 通常動作の準備が整ったこと を意味します。

図 2-12: デバイスのプログラ ミ ング
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メ モ :
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EXPLORER 16 開発ボー ド

ユーザーズ ガイ ド
第 3 章 :   Explorer 16 チュー ト リ アル プログラム
3.1 はじめに

本章では、 前章のチュート リ アルでプログラムした PIC24 および dsPIC33F のファー
ムウェアについてさらに詳し く説明します。 

3.2 PIC24 チュー ト リ アル プログラム 
PIC24 チュート リ アル プログラムは 3 つのコンポーネン トで構成されています。 こ
れらは、 それぞれ LCD に表示されます。 このプログラムでは、 LCD をド ラ イブする
新しいパラレル マスタ  ポート  (PMP) モジュールおよびリ アル タイム  ク ロ ッ ク / カレ
ンダー (RTCC) モジュールについて実演します。 図 3-1 に、 このプログラムのフロー
を示します。

3.2.1 PIC24 の機能

機能モードでは、 PIC24FJ128GA010 デバイスの機能セッ トの説明が繰り返し表示さ
れます。 [S4] を押して次のモードへ変更します。

3.2.2 電圧メ ーター / 温度

電圧メ ーター / 温度モード では、コード  モジュール (vbanner.c および ADC.c) およ
び A/D モジュールを使用して、 ボード からのアナログ信号を測定して、 それを変換し
て  LCD 表示します。 ポテンショ メ ーター (R6) から電圧の値を測定し、 LCD の 1 行目
に 0.00V ～ 3.29V の電圧値を表示します。 温度情報は、 TC1074A アナログ温度セン
サー (U5) から取得します。 この値は、 LCD の 2 行目に表示され、 自動で摂氏 / 華氏の
両方を交互に表示します。 電圧と 温度の値は、 常に更新されます。

[S5] を押すと、 ボード上にあるシ リ アル EEPROM に現在の温度の値を保存できま
す。 [S6] を押すと、 現在の温度と保存した温度を切り替え表示できます。 LCD の右
側に 「M」 が表示されている と きは、 保存された温度の値が表示されているこ とを意
味します。 
[S4] を押して次のモードへ変更します。

3.2.3 ク ロ ッ ク / カ レンダー

ク ロ ッ ク / カレンダー モードでは、 rtcc.c および tbanner.c モジュールのコード
を使用します。 メ イン  メニューから このモードに入る と、 リ アル タイム ク ロ ッ クが 
10:00:00 から開始し、 「Oct. 10, 2005」 のよ うに日付表示します。 新しい RTCC モ
ジュールと  32kHz ク ロ ッ ク  ク リ スタルを使用するこ とで、 日付カレンダー表示付き
のリ アル タイム ク ロ ッ ク機能を実現しています。 
ク ロッ ク / カレンダー モード では、 ユーザー用プッシュ  ボタンで次の操作が可能です。

• [S3] -  クロック設定モードをトグルし、日付と時間を設定できます。この設定
モードは、10 桁の時刻表示で開始します。 

• [S4] -  現在の項目を決定し、カーソルを次の項目へ進みます。

• [S5] -  現在の項目をデクリメントします。

• [S6] - 現在の項目をインクリメントします。
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[S3] を押すと、 時刻表示の 10 桁部分に点滅したカーソルを表示します。 [S4] を押す
たびにカーソルが 月 / 日 / 年の順に移動します。 [S3] を押すと、 通常のクロ ッ ク / カ
レンダー表示に戻り ます。 再び [S4] を押すと、 ク ロ ッ ク / カレンダー モードを終了
し、 PIC24 の機能モードに戻り ます。

LCD へ送られたデータは、 UART を使用して RS-232 シ リ アル ポートにも送られま
す。HyperTerminal ( ほとんどの Microsoft® Windows にデフォルトでインス トールされ
ている ) などの端末エミ ュレータでは、 同じ情報を表示できます。 表示する場合は、
端末エミ ュレータを、 19200 ボーレート、 8 ビッ トデータ、 1 ス ト ップ ビッ ト 、 パ リ
ティなしに設定します。
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図 3-1: PIC24 チュー ト リ アル プログラムのフ ロー図

3.3 dsPIC33F チュー ト リ アル プログラム 
dsPIC33F チュート リ アル プログラムは、 5 つのシンプルなプロセスで構成されてお
り、 dsPIC33FJ256GP710 デバイスで連続して実行します。

• Timer1 を使用したリアル タイム クロック (RTC) 
• ポテンショメーターの A/D 変換 (R6)
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• A/D 電圧から 16 進数への変換

• 16 進数から 10 進数への変換 (LCD 表示用 )
• LCD の更新

時刻および A/D 変換の値は、 常に更新されて LCD に表示されます。 このプログラム
では、 Timer1 を初期化する基本コードについてデモンス ト レーシ ョ ンし、 Timer1 オ
シレータを RTC 動作させ、 A/D をシグナル チャネル変換に初期化し、 ポテンシ ョ
メーター (RP5) に使用します。 LCD はポート  ピンを使用して駆動されます。 図 3-2 
に、 このプログラムのフロー図を示します。

このチュート リ アルに加えて、 Explorer 16 の CD には高度なプロセッシング要件 
(DMA、 デジタル フ ィルタ、 高速フーリエ変換 (FFT) など ) を理解するためのコード
の例が含まれています。 これらの詳細は、 CD の 「Code Example 2」 を参照して くだ
さい。

3.3.1 電圧メ ーター

シンプルなチュート リ アル プログラムは、 A/D モジュールを自動サンプリ ング機能
の付いた 12 ビッ ト  モード、 および AN5 ピンに接続したポテンシ ョ メーターの変換
用に初期化し、 各割り込みを初期化します。 この A/D モジュールは、 連続的にサン
プリ ングを実行し、アナログ チャネル AN5 のポテンシ ョ メーター信号 (0 ～ 3.3VDC) 
を変換します。 変換完了後、 割り込み信号が生成され、 ADCBUF0 レジスタの結果が
テンポラ リ変数 (temp1) にコピーされます。 adc_lcd_update フラグがセッ ト さ
れ、 A/D 割り込みフラグ (AD1IF (IFS0<13>)) がク リ アされます。

このプログラムは、 割り込みサービス  ルーチンを終了し、 メ イン  プログラムのルー
プに再び入り ます。 メ イン ループでは変数 adc_lcd_update を確認し、 LCD に表
示する新しい A/D 変換の値があるのか判断されます。

ADC モジュールの動作と 表示に関連するプライマリ  コード  モジュールを次に示します。

• init_ADC.c
• isr_ADC.c
• advolts.c
• hexdec.c

3.3.2 リ アル タ イム ク ロ ッ ク

チュート リ アル プログラムでは、 リ アル タイム ク ロ ッ クをサポート しています。
Timer1 は、 割り込みイネーブルで初期化され、 外部 32.768kHz オシレータは有効に
なり ます。 Timer1 の割り込みサービス  ルーチン (1 秒に 1 回 ) 中に、 変数 ( 時間、 分、
秒 ) が更新され、 フラグ変数 rtc_lcd_update がセッ ト され、 Timer1 割り込みフラ
グ T1IF (IFS0<3>) がク リ アされます。

このプログラムでは、 割り込みサービス  ルーティーンを終了し、 メ イン プログラム
のループに再び入り ます。 メ イン ループでは、 変数 rtc_lcd_update を確認し、
LCD に表示される新しい時刻があるか否かが判断されます。

Timer1 モジュールの動作と表示に関連するプライマリ  コード  モジュールを次に示します。

• init_timer1.c
• isr_timer1.c
• hexdec.c
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図 3-2: dsPIC33F チュー ト リ アル プログラムのフ ロー図
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ユーザーズ ガイ ド
第 4 章 :   Explorer 16 開発ハー ド ウェ ア
4.1 はじめに

本章では、 Explorer 16 開発ボードのハード ウェア機能の詳細を説明します。 

4.2 ハー ド ウ ェ アの機能

Explorer 16 開発ボードの主な機能を次に示します。 1.4 「Explorer 16 開発ボードの機
能および特長」 で示す順番に従って説明します ( 図 1-1)。

4.2.1 プロセ ッサ サポー ト

Explorer 16 開発ボードは、 実装 ( はんだ付け ) されたプロセッサおよび取り外し可能
な PIM プロセッサの両方に対応して設計されています。 ユーザーは、 スライダー ス
イ ッチ (S2) を使用して、 使用するプロセッサを選択できます。 したがって、 Explorer 
16 開発ボードは、 適切な PIM を使用し、 3V、 16 ビッ ト 、 ピン互換のマイ クロプロコ
ン ト ローラをサポートできるよ うになっています。 
PIM を正常にインス トールするための目印があ り ます。 必ず PIM ボードの角がくぼ
んだ部分を左上にしてインス トールして ください。

現在のリ ビジ ョ ンのボードには、 U1 に実装されたマイ クロコン ト ローラはあ り ませ
ん。 ボードを動作させるためには、 S2 を 常に PIM 位置に設定する必要があ り ます。
今後、 U1 に PIC24 デバイスが実装された場合は、 S2 を  PIC 位置に設定する とボード
上のデバイスが有効になり、 PIM ソケッ トが無効になり ます。

4.2.2 電源供給

Explorer 16 開発ボードへ電源供給する方法は、 2 つあ り ます。

•  9V ～15V (推奨 9V) のレギュレータを使用しない DC 電源から J12 へ電源供給
します。 デフォルト機能の場合、電流許容量が 250mA の電源供給で充分です。
複数の拡張ボードに接続するようなモジュラー開発プラットフォームとしてボー
ドを使用する場合は、 最大電流許容量 800mA の電圧レギュレータ  (Q1 および 
Q2) を使用します。 この場合は、 最大 1.6A の電源供給が必要になり ます。 レギュ
レータにはヒート シンクが付いていないので、 こ よ う な負荷での長時間動作は推
奨しません。

• 外部のレギュレータ付き  DC 電源 (+5V および +3.3V) は、提供されたターミナル 
( ボードの左下、 S3 付近 ) に接続できます。

Explorer 16 開発ボードに電源が入ったこ とを示すために、 緑色の LED (D1) があ り ま
す。 これが点灯する と、 +3.3V であるこ とを表します。 

メ モ : Explorer 16 キ ッ ト には、 電源装置は含まれていません。 外部電源が必要
な場合は、 マイ ク ロチ ッ プの型番 AC162039 を使用し て く だ さい。

メ モ : MPLAB ICD 2 モジュールは、 USB バス電源ソース と し て設計されていな
いため、 これを使用し て、 Explorer 16 開発ボー ド に電源投入し ないで く
だ さい。
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4.2.3 RS-232 シ リ アル ポー ト

RS-232 レベル シフタを含め、 すべての必要なハードウェアが提供され、 DB9  コネク
タを使用したハードウェア フロー制御と  RS-232 の接続をサポート します。 このポー
トは、 DCE デバイス と してコンフ ィギュレーシ ョ ンされ、 ス ト レート  ケーブルを使
用して PC へ接続できます。

PIC24/dsPIC33F の RX および TX ピンは、 U3 の RX と  TX ラインへ接続されます。
PIC24/dsPIC33F の RTS および CTS ピンは、 ハード ウェア フロー制御のため、
MAX3232  の RX2 (DIN2) と  TX2 (DOUT2) ラインへ接続されます。

4.2.4 温度センサー

アナログ出力温度センサー ( マイ ク ロチップ TC1074A、U4) は、 コン ト ローラの A/D 
チャネルへ接続されます。

4.2.5 USB コネク テ ィ ビテ ィ

Explorer 16 開発ボードには、 PIC18LF4550 USB マイ ク ロコン ト ローラが含まれてお
り、 USB コネクティ ビティ とプロ ト コル変換をサポート します。 PIC18LF4550 は、
PIC24/dsPIC33F デバイス とハード  ワイヤ接続され、 次の 3 種類のコネクティビティ
を提供します。

• PIC18LF4550 の SPI™  から PIC24/dsPIC33F の SPI1
• PIC18LF4550 の I/O ピンから PIC24/dsPIC33F の ICSP™ ピン 
• PIC18LF4550 の I/O ピンから PIC24/dsPIC33F の JTAG ピン

コネクティ ビティの種類は、 PIC18LF4550 にインス トールしたファームウェアに
よって異なり ます。 初期リ リースの場合、 PIC18LF4550 は、 USB ブート ローダー 
ファームウェアでロード されるため、 USB コネクティ ビティ  ファームウェアのアッ
プグレードが容易になり ます。 このファームウェアのインス トールの詳細は、 付録 
B. 「USB 接続のアップデート 」 を参照して ください。

PIC24 と  dsPIC33F デバイスは、 5V 許容の入力ピンが複数あ り ます。 5V 入力が  
PIC18LF4550 に接続される と、 PIC18LF4550 デバイスのポート  ピンの保護ダイオー
ドが入力を VDD に制限します。 16 ビッ ト  デバイスの 5 V 許容 ピンの詳細は、 該当
するデバイスのデータシート を参照して ください。

4.2.6 ICD コネク タ

MPLAB ICD 2 モジュールは、 モジュラー コネクタ  (JP1)  を使用して接続し、 低コス
ト  デバッグを行います。 ICD コネクタは、 マイ ク ロコン ト ローラのポート  ピン  RB6 
と  RB7 を利用して、 インサーキッ ト  デバッグを行います。

ジャンパ J7 は、 ICD 2 コネクタの接続先を決定します。 PIC24 側にジャンパを設定し
た場合は、 JP1 が直接 PIM の RB6/RB7 またはボード上のデバイス と通信します ( S2 
で決定 )。 F4450 側にジャンパを設定した場合は、 JP1 がボード上の PIC18LF4550 
USB デバイス と通信します。

4.2.7 LCD

Explorer 16 開発ボードには、英数字 16 文字を  2  行表示できる  LCD ディ スプレイがあ
り ます。 このディ スプレイは、 3 つの制御ライン (RD4、 RD5、 RD15) と  8 つのデータ  
ラ イン (RE7:RE0) で駆動されます。 PIC24 デバイスの場合、 LCD は I/O ポートではな
く、 PMP モジュールで駆動されます。

Explorer 16 開発ボードには、 複数の LCD フッ トプ リ ン トがあ り、 いくつかのオプ
シ ョ ンがサポート されています。 ただし、 各フッ トプ リ ン トは 1 回のみコンフ ィ
ギュレーシ ョ ン可能です。 Lumex LCM-SO1062 (LCD4 に実装 ) は、 TTL 入力の 5V 
LCD で、 Explorer 16 開発ボードの初期バージ ョ ンで使用されています。 Tianma 
TM162JCAWG1 (LCD1 に実装 ) は、 3V LCD です。 これは、 ボードの今後のバージ ョ
ンで使用される予定です。
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選択するコンフ ィギュレーシ ョ ン  オプシ ョ ンによっては、 RE7:RE4 の代わりに  
RD3:RD0 を 4 つのデータ  ラ インと して使用できます。 これを行うには、
R60/62/64/66 の ト レース  ジャンパを切断して、R61/63/65/67 のパッ ドからのソルダー 
ブリ ッジを作成する必要があ り ます ( 図 4-1 参照 )。 

図 4-1: R60-R67 を変更し た LCD コ ン フ ィ ギュ レーシ ョ ン 
( 拡大表示 )

4.2.8 グラ フ ィ ッ ク  LCD
Explorer 16 は、 Optrex 128 x 64 ド ッ ト マト リ ク スのグラフィ ッ ク  LCD ( 型番 F-
51320GNB-LW-AB) と 、 それに関連する回路用のフッ ト プリ ント およびレイアウト  が
サポート されています。 これは、 マイク ロチッ プの MPLAB PM3 プログラマで使用さ
れているディ スプレイと 同一です。

4.2.9 スイ ッ チ

5 つのプッシュ  ボタン  スイ ッチは、 次の機能があ り ます。

• S1 : アクティブ low の MCLR スイッチは、プロセッサをハード リセットする

• S3 : RD6 へ接続する アクティブ low スイッチ ( ユーザー定義 )
• S4 : RD13 へ接続する アクティブ low スイッチ ( ユーザー定義 )
• S5 : RA7 へ接続する アクティブ low スイッチ ( ユーザー定義 )
• S6 : RD7 へ接続する アクティブ low スイッチ ( ユーザー定義 )

スイッチ S1 には、 デバウンス  キャパシタがあり ます (S3 ～ S6 にはない )。 これによ
り 、 ユーザーはデバウンス処理方式を検証できます。 Idle ステート の時、 スイッ チは 
High (+3.3V) にプルアップされます。 スイッチを押すと グランド 接続します。 

4.2.10 アナログ入力 ( ポテンシ ョ メ ーター )
10kΩ のポテンシ ョ メーターは、 直列レジスタを介して AN5 へ接続します。 VDD か
ら  GND へ調整して、 コン ト ローラの A/D チャネルにアナログ入力を提供できます。

4.2.11 LED

8 個の赤色 LED (D2 ～ D9) は、 PIM ソケッ トの PORTA に接続しています。 PORTA ピ
ンが High になる と  LED が点灯します。 これらの LED を無効にする場合は、 ジャン
パ JP2 を切断します。

4.2.12 オシレータ  オプシ ョ ン

インスト ールされたマイクロコント ローラには、 2 つのオシレータ回路があり ます。
主要なオシレータは、 8MHz ク リ スタル (Y3) を使用し、 コント ローラのプライマリ   オ
シレータと して機能します。 2 つ目のオシレータ回路は、 32.768kHz ( 時計 ) を使用し、
Timer1 オシレータや RTCC のソースと なるセカンダリ  オシレータと して機能します。

USB サブシステムの中心にある  PIC18LF4550 に は、 独立クロ ッ ク と して専用の 
20MHz ク リ スタル (Y1) があ り ます。
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ソルダー
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4.2.13 シ リ アル EEPROM
不揮発性ファームウェア ス ト レージには、25LC256 256K (32K x 8) シ リ アル EEPROM 
(U5) が含まれています。 これは、 SPI バスの動作をデモンス ト レーシ ョ ンする と きに
も使用されます

4.2.14 PICkit 2 コネク タ

コネク タ  J14 は、 6 ピン PICkit 2 プログラマ インターフェイス用のフッ トプ リ ン ト を
提供します。 今後、 PICkit 2 が大規模デバイスをサポートできるよ うになる と、
MPLAB ICD 2 と  JTAG インターフェイスに続いて 3 番目の低コス ト なプログラ ミ ン
グ オプシ ョ ンとな り ます。

4.2.15 JTAG コネク タ

コネク タ  J13 は、 標準的な JTAG インターフェイスであ り、 JTAG を使用したコン ト
ローラへの接続およびプログラムが可能になり ます。

4.2.16 PICtail™ Plus カー ド  エ ッ ジ モジュ ラー拡張コネク タ

Explorer 16 開発ボードは、 PICtail™ Plus モジュラー拡張インターフェイスを使用して
設計されているため、 基本的な機能を提供するだけでなく、 さ らに新しいテク ノ ロ
ジへと容易に拡張できます。 
PICtail Plus が使用する  120 ピン  コネク タは、3 つのセクシ ョ ン ( 上から  30 ピン /30 ピ
ン /56 ピン ) に分割されます。 上部 2 つの 30 ピン セクシ ョ ンは、 並列機能とな り ま
す。 たとえば、 上部 30 ピンセクシ ョ ンのピン  1、 3、 5、 7 が  SPI1 機能とな り、 中間
の 30 ピン セクシ ョ ンの同じ位置 (33、 35、 37、 39) も、 同等の SPI2 機能とな り ます。 
各 30 ピン セクシ ョ ンは、 すべての直列通信ペリ フェラル、 多数の I/O ポート、 外部
割込み、 および A/D チャネルと接続できます。 さまざまな拡張インターフェイス  
(Ethernet、 Zigbee™、 IrDA® など ) を展開するには充分な信号が提供されます。 この 
30 ピン PICtail Plus  拡張ボードは、 上部または中間の 30 ピン セクシ ョ ンのいずれか
で使用できます。

Explorer 16 開発ボードは、 ドーター カード用の 2 エッジ コネクタのフッ トプ リ ン ト
を提供します。 1 つは実装済み (J5、 Samtec # MEC1-160-02-S-D-A)、 も う  1 つは実装
されていません (J6)。 ボードにはオス接続コネク タ  (J9) がサポート されているため、
拡張カード と しても使用できます。

4.2.16.1 SPI および UART のクロスオーバー接続

PICtail Plus インターフェイスは、外部コネクタを使用せずに、 2 つの Explorer 16 開発
ボードを直接相互接続できます。 これは、 2 つのボード上のマイ クロコン ト ローラの
直接接続を可能にしたり、 多様なペリ フェラル (I2C、 PMP など ) に対しても有効な
インターフェイスを提供します。 ただし、 特定の直列ペリ フェラル モジュール (SPI 
および UART) の場合は、 ク ロス  ワイヤ接続が必要になり ます。 つま り、 一方のコン
ト ローラの TX ( または SDO) ピンをも う一方のコン ト ローラの  RX ( または SDI) ピ
ンへ接続する必要があ り ます ( 逆も同様 )。
Explorer 16 開発ボードは、 2 つの  74HCT4053 アナログ マルチプレクサを使用して、
ドーター ボード との接続を簡潔にしています。 U6 および U7 では、 3 つの I/O ピンで
提供されるハード ウェア フロー制御信号を使用して、 SPI1 および UART1 でのクロ
ス  ワイヤ接続能力を制御します。

マルチプレクサは、 RB12、 RB13、 および RB14 ピンのステートによって制御されま
す。制御ピンが High ( デフォルト ) の場合には、対応する  SPI1 または UART1 ピン ペ
アが PICtail Plus インターフェイスのデフォルト  ピンへ接続されます。 制御ピンが 
Low に制御される と、対応するピン  ペアのファンクシ ョ ンがスワ ップします。表 4-1 
では、 このインターフェスにおける制御ピンと   SPI1/UART1 ファンクシ ョ ンの関係
を説明します。
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表 4-1 : PICtail™ PLUS イ ン ターフ ェ イスにおける SPI1 および 
UART1 ピンのフ ァ ン ク シ ョ ン

制御ピンの
ステート

UART1 制御ピン SPI1

制御ピン RB14 制御ピン RB13 制御ピン RB12

U1RX U1TX U1CTS U1RTS SDI1 SDO1

1 2 4 19 20 5 7
0 4 2 20 19 7 5

メ モ : 2 つの Explorer 16 開発ボー ド上で SPI と  UART を接続する場合は、 片方
ボー ドのみでク ロスオーバー接続を使用し て く だ さい。
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メ モ :
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エクスプローラ  16 開発ボー ド

ユーザーズガイ ド
付録 A. Explorer 16 開発ボー ド  の回路図
A.1 はじめに

本章では、 Explorer 16 開発ボードの技術的な情報を提供します。

A.2 開発ボー ドのブロ ッ ク図

図 A-1: Explorer 16 開発ボー ドの概略ブロ ッ ク図
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* ハードウェアのみ。 USB を使用する  SPI™、 JTAG、 および ICSP™ は、 現在サポート していません。

および
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A.3 開発ボー ドの回路図

図 A-2: Explorer 16 開発ボー ドの回路図 ‐ シー ト  1/8 (PIM ソケ ッ ト )
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Explorer 16 開発ボー ド  の回路図
図 A-3: Explorer 16 開発ボー ドの回路図 ‐  シー ト  2/8
(PIC24FJ128GA010 MCU がボー ド に実装された状態 )
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図 A-4: Explorer 16 開発ボー ドの回路図 ‐  シー ト  3/8 
(MPLAB® ICD 2、 JTAG、 PICkit™ 2 および PICtail™ Plus コネク タ )

MPLAB® ICD 2 Connector

.1 µF

PICkit™ 2 Programmer
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Explorer 16 開発ボー ド  の回路図
図 A-5: Explorer 16 開発ボー ドの回路図 ‐  シー ト  4/8
(PICtail™ Plus エ ッ ジおよびソケ ッ ト  コネク タ )
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図 A-6: Explorer 16 開発ボー ドの回路図 ‐  シー ト  5/8 
( スイ ッ チ、 マルチプレ クサ、 およびポテンシ ョ メ ーター )
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Explorer 16 開発ボー ド  の回路図
図 A-7: Explorer 16 開発ボー ドの回路図 ‐  シー ト  6/8 
(EEPROM、 温度センサー、 LED、 オシレータ回路および電源装置 )
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図 A-8: Explorer 16 開発ボー ドの回路図 ‐  シー ト  7/8 
(USB および UART サブシステム )
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Explorer 16 開発ボー ド  の回路図
図 A-9: Explorer 16 開発ボー ドの回路図 ‐  シー ト  8/8
(LCD、 およびオプシ ョ ンの LCD 接続 )
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メ モ :
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EXPLORE 16 開発ボー ド

ユーザーズ ガイ ド
付録 B. USB 接続のア ッ プデー ト
B.1 はじめに

Explorer 16 開発ボードの USB サブシステムは、 USB ブート ローダー ファームウェア
であらかじめプログラムされています。 これによ り、 PIC18LF4550 ファームウェア
を容易にアップグレードでき、 PIC24 および  dsPIC33F デバイスへの  ICSP、 JTAG、
および SPI の接続をサポートできます。

本章では、 PICkit 2 ソフ ト ウェアを使用して、 PIC18LF4550 デバイスのファームウェ
アをアップグレードする方法を説明します。 新フォームウェアが提供される時、
PIC18LF4550 デバイスのファームウェアをアップグレード場合も同じ手順を使用で
きます。 

B.2 PICkit 2 マイ ク ロ コ ン ト ローラ  プログラマをア ッ プデー ト

まず最初に、 PICkit 2 プログラマ ソフ ト ウェアをインス トールする必要があ り ます。
インス トールの説明およびプログラマ ソフ ト ウェア アプ リ ケーシ ョ ンの使用方法に
ついては、『PICkit™ 2 マイ クロコン ト ローラ  プログラマ ユーザー ガイ ド』 (DS51553) 
を参照して ください。 プログラマ ユーザー ガイ ド、 および PICkit 2 オペレーティン
グ システム ファームウェアの最新情報は、 マイ ク ロチップのウェブ サイ ト  
(www.microchip.com) から入手できます。

USB ファームウェアをアップデートする手順は次のとおりです。

1. 最新の PICkit 2  オペレーティング システム ソフ ト ウェアをマイクロチップ ウェ
ブ サイ トからダウンロード します ( すでにダウンロード済みの場合は不要 )。

2. Explorer 16 開発ボードで、 JTAG コネク タ  (J13) の 9 ピンと  10 ピンの間にジャ
ンパを 1 個インス トールします。

3.  MCLR (S1) を押して リ リースします。 これで USB サブシステムが ブート ロー
ダー モードになり、 新しいコードを受け取る準備ができます。

4. 標準の USB ケーブルを使用して、 Explorer 16 開発ボードを  PC に接続します。

5. PICkit 2 プログラマ ソフ ト ウェアを起動します。 メニュー バーから  [Tool] → 
[Download PICKit 2 Operating System] を選択します ( 図 B-1)。

図 B-1: [DOWNLOAD PICkit™ 2 OPERATING SYSTEM]
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6. 最新のオペレーティング システム ファームウェアが保存されているディ レク
ト リ を参照します ( 図 B-2)。

図 B-2: [SELECT PICkit™ 2 OPERATING SYSTEM ] ウイ ン ド ウ

7. PK2_Explorer16_*.hex ファイルを選択して、[Open] をクリックします。

プログラ ミ ング ソフ ト ウェアのステータス  バーにアップデートの進行状況が表示さ
れます。 アップデートが完了する と、 「Operating System Verified」 と表示されます。

B.3 その他の USB フ ァームウ ェ ア ア ッ プデー ト

今後、 さまざまな USB 接続ファームウェアの利用が可能になり ます。 マイ ク ロチッ
プ ウェブ サイ ト  (www.microchip.com) を定期的にチェッ ク して、最新のコードを確認
するこ とを推奨します。
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